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Document Overview

This document is intended to educate users about the full functionality of TBSI’s online data
acquisition software. NeuroWa re© has the capability to graphically display and store up to 32
simultaneous channels of neural data.

Svstem Overview

Receiver s

Neuro%‘Ware
Data Acquisition Certified

-

Headstage
Transmitter

NeuroWare® is designed to interface seamlessly with all
TBSI tethered and wireless (shown above) neural recording systems.
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Standard Shipped items list

e 1 Wireless headstage

e 1 Magneton/off wand

e 1 Wireless receiver/demuxbase station
e 2receiverantenna

e 2 receiverantennaextension cables
e 2 antenna damps

e 1USBA-B cable

e 16vpowersupply

e 1 headstage charger

e 1 headstage testcable

e 1 headstage shorting plug

System Requirements

The recommended minimum PC requirements are as follows:
e Atleasti7 Quad Core Processor
e 8 GBRAM,DDR1333 orhigher
e 512MB of video memory
e C:drive (OS) SATA 2 3GB/S or faster, 250GB orgreater

e D:drive (storage) SATA 3 6GB/S SSD 500GB or greater RECOMMENDED HARDWARE IS A
SATA 3 (6GB/S) SAMSUNG EVO SSD 500GB OR LARGER.

e USB2.0port
e Windows 7 64 bit OS

System /0
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e POWER INPUT —This is to be connected to the 6V DC powersupply provided by TBSI
only.

Analog Input - TTLinput, 5V, 30kS/s.

DATA A —Digital Eventsinput

DATA B —Digital Eventsinput

USB A — Primary ADCI1/0O connection

USB B —Secondary ADCI/O connection

GND — Earth ground connection lug

DATA I/0 — Not supported

Headstage input pinout - refer to appropriate channel hardware manual
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NeuroWare® Installation

Install the driver for the USB-2533 DAQ card

e Navigate to CD drive:\NeuroWare\DAQ Drivers and run mccdag.exe.

e Follow the prompts to install the DAQdrivers and the Instacal and TracerDAQ software

tools.

e You maybe required to restart your computeronce installation is complete.

Install NeuroWare

e Navigate to CD drive:\NeuroWare Installer\Volume and run the file labeled setup.exe.
o Follow the prompts to install the NeuroWa re®software.

Copy files from Installation CD to PC

e Copy the TBSI folder on the installation CD to the C:\ drive on your PC.

© File Edit View Favorites

@Back - \_:,1 l.@ pSaarch H

Tools  Help

Folders v @ @ Folder Svnc

: Address |[E] C:TBSI

File and Folder Tasks

(29 Make & new foldsr

@ Publish this folder to
the weh

4 Share this Foldsr

Other Places

age Local Disk {C:)
5} My Documents
[3) Shared Documents
Ei My Computer

& My Metwork Places

|

backup

configure file  recording file  Error Log.kxt

Configure the DAQ card’s channel number in Instacal
e Connect the receiver to your computerwith the USB cable.
e Your computerwill detect this as a new device andinstall additional drivers

automatically.

e Once the driversare installed, you maynavigate to the Device Manageron your
computerand check to see if “DAS-COMPONENT-USB 2533” is induded the list of

available devices.

e Run the newlyinstalled Instacal program.
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@ Set Program Access and Defaults

'@ WWindows Catalog
% WWindows Update

@ Accessories 4
@ Microsoft Office ¥
W
:9 Documents 3 @ LagMeIn
[ wilin I5E Design Suite 11 »
Ef Settings ’
rﬁg Measurement Computing Instacal

)_J Search v [IE Mex Technologies @) TracerDaQ b
[T MaTLAB v
t’/] Help and Support B Neuralynx N

¥=J] Run... v

E Log Cff Zeb, ..

@ Turn OFF Carmputer...

e InInstacal, you will see Board# 0 - USB-2533 (serial#******) under Universal Serial
Bus. (Note: Each DAQboardis assigned a differentserial number, but the board
numberin Instacal should always be “0”.)

InstaCal
File Install Calbrate Test Help

I mcm
A

[[uxm
D/A

a4

l] Board# 0 - USE-2533 (serial# 345537)

Ready l_ IW L

% If you can’tsee a device like this, check the system’s USB and power connections.
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e Right-cdidk the DAQboardshownin the list, then dick Configure. Select 64 Single
Ended in the field for No. of Channels. Click OK to accept these changes.You may
now dose the Instacal program window.

Board Configuration |Z|
T L5B-2533 i
InstaCal =13 | Temperature [nput Settlngsl
&N Calbrate Test  Help Serial # 345537
Add Board. .. oK oK A 7 Mo. of Channels: |EER e N e
ez | (125171 ; £
Remove Board a&D | b2
Refresh W Calibration Coefficients: IFactory vl
#APCH Edge: IHising vl
Add Exp Board. ., *APCR Pin Direction: Ilnput vl
Add Memory Board «DPCR Edge: lm
&dd MetraBus Board. ..
#DPCR Pin Direction: Ilnput vl
Remave Al -
InskaCal AukoRun. .. ADC Settling Time: I‘Ius VI
ADC Maximum Rate: [1 MHz

Perfarmance Test

Ade Fifo Input Speed:

Digital 1/0 Input Speed:

Fun

ak. I Cancel
Configure board settings. | A

% A screen resolution of at least 1280x1024 is recomme nded to run NeuroWare®.

Loading and Configuration

e Start NeuroWare

You can run NeuroWare® via the Windows Start Menu by navigating to Start/All
Programs/NeuroWare.

If there is no rightlicense file namedas “NeuroWare licence.dat” in C:\TBSI\configure file,
NeuroWare may run in demo mode.ln demo mode Recording is disabled.

e Load a Configuration File

Uponloading NeuroWa re® for the first i me, you will be asked to selecta configuration file.

Each configuration file contains program functionality settings fora specific TBSI recording
device.
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Choose the configuration file which matches your data acquisition hardware model (ex. a file
ending in M32 should be used with a 32 channel M-Series recordingsystem).

Enter Configuration Filename:*.ini

Loak ir: |E} configure file V| Q2 e -

Ty default For Meuroware Y2 M2, i
4 E; b deFaulk for Meuroware ¥2.0 Single-TS in

My Recent b deFaulk for Meuroware ¥2,0 Single-T9| TyPe: Configuration Settings

= ) Date Modified: 2013-4-3 22:57
Documents b defaulk for Meuroware ¥2.0 Single-T1 Size: 915 KE

— b deFaulk For Meuroware ¥2,0 Single-T3lmm
£ b default for Meuroware ¥2,0 Single-WS.ini
Deskiop 3default fFor Meuroware ¥2.0 Single-YW16.ini I
b default For Meuroware ¥2,0 Single-W3Z, ini
; }default for Meuroware ¥2,0 Single-Wed-1.ini
‘-} }Neumware Configuration. ini

My Documents

-

ky Computer

File name: ||:Iefau|t for Heuroware V2.0 Single-t32.ni W | I Ok, ]

@ﬁf

by Mebwark Files of type: | Custam Pattern [*.ini) - | [ Cancel ]

e Configure NeuroWare©
Adjusting Settings in a Configuration File

To change and save selected DAQ settings to be loaded in future instances of NeuroWa re©,
navigate to the Tools menu at the top left of the program, then select Configuration from the
drop-down menu to open the Configuration Dialog.

Manysettings in the Configuration Dialog are unique to that menu and can’t be accessiblein
NeuroWare . Itis recommended to reviewall settings in the Configuration Dialog to ensure
thateach parameteris appropriatelydefined. Refer to othersections for how to set up those
settings thatare onlyaccessible in Configuration. Be sure tostop DAQ before opening the
configuration dialog.

e Load New Config
Use this button when you want to load a new configuration file.
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e Save
Use this button to overwrite the default configuration file provided by TBSI or Save As to open

a prompt forsaving a new configuration file.

e Returnto NeuroWare
Use this button when you have completed andsavedall changes to your configuration file.

e Daqtab
Under the DAQtab of the Configuration Dialog you will see a mapping of the physical channels
(this cannot be edited)and the Sample Rate drop down box. The default sample rate is 30k
cycles /second which is the ideal sample rate forspike recordings. This can be lowered
significantlyif only LFP data will be recorded.

'E Canfiguration Dialag V1.8 b

ALy | Spike | LFP‘l Motch Filter | Chan Display | Reference | Record Daa | Ewrl.l System Gain |

A

Neuro §Ware

Load New Config

Sane

Save Ag

Feturn bo
MeuraWare

e Spike Tab
Minimum Spike Width: Sets the minimum numberof DAQsamples required to cross the
threshold(s) to allow that portion of data to be registered as a spike.

Pre Spike Samples: the number of samples the spike chartdisplays to the left of the triggered
data.

Windows Samples: This is the number of samples shown in the Spike Display Window.

Spike Repeat(<200): the numberof detected spike waveform overapped in the Spike Display
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Window

Spike Filter: Alow cutoff frequency of more than 100Hzis recommended to remowe the low-
frequency componentsignal. Taps determine the order of the digital filter. Selecting an odd
number larger than 101 is recommended.

Threshold Selection: There are two threshold are available toset up the threshold lewels.
Threshold1: Only Threshold1is enabled.
Threshold2: Only Threshold2is enabled.
Threshold1 and Threshold2: Both Threshold1 and Threshold2 are enabled.
Only Spikes crossing Threshold1and Threshold2 will be detected.
Threshold1 or Threshold2: Both Threshold1and Threshold2 are enabled.
Spike crossing either Threshold1 or Threshold2 will be detected.

Trigger Oder: (onlyavailable when Threshold1 and Threshold2is selected in Threshold
Selection )

Threshold Level: This displays the amplitude in uV. Thateach channels Threshold is set at.

e LFP Tab
LFP sample rate: Thisis the sample rate at which LFPsignal is acquired and displayed. Since LFPs do
not require as high a sample rate as Spike recordings this tab gives you the option to sample LFPs ata
much lower sample rate.

LFPfilter: Alowpass filteris used to remove unwanted high frequencynoise and signals. Adjust
filte rbandwidths by changing low cutfrequency. The high cut frequency will be ignored when you
use the lowpass filter. The “taps” is the orderofdigital filter. An odd number more than 101 is
recommended. The “window” option affects the digital filterperformance. If the “dick to enable”
buttonis on, the current filteris used. If the “dick to enable” button is of”, the current filter is off.
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e Notch Filter Tab
A Notch Filter can be applied to the raw data of all channels from DAQ card. The default cutoff
frequendies are setaround 60Hz rejection. Itis recommended to review the Notch Filter Settings
under the Filters tab before setting up spike triggering conditions and browsing spike and LFP
wa veform.

Filter Selection: The default filter is Butte rworth filter.

e Chart Display Tab
Display Mode/Strip Display Mode:
Strip Chart: displays the selected channel’s data as a constantlyscrolling stream
Scope Chart: refreshes entire window with new data after chartis filled
Sweep Chart: same as scope chart, but continues to display previous data until itis
overwritten bynewerdata
Multiple chs Window Config:
Window Width (ms): adjusts the maximum amount of x-data displayed ata time
Display Zoom: increases or decreases the zoom of the Y-axis.
Strip Window config:
Data Select
Raw Data: displays theincoming raw data (unfiltered)
Spike Waveform: displays the selected channel with spike filter settings applied
LFP Waveform: displays the selected channel with LFP filtersettings applied

e Reference Tab
Neuroware is set default to reference from the headstage “AGND” which should be connected
to an animal groundimplant. If you wish toinstead use differential referencing from a spedific
recorded channel dick the oval Enable Referencing button. When enabled, the green lighton
the oval button will be lit.
Reference Channel Setting: This function isalso available through the Reference Tabin Neuroware .
For each channel you are able to set up separate reference channels for Spike data and LFP data
recordings.

e Record Data Tab
File save path: The defaultfile pathis “C:\TBSI\recording file. Howeer, itis highly
recommended that you change this path toan appropriatelysized SATA 3 Solidstate storage
drive or highspeed RAID array.
Recording Data Selection: You can select to record simultaneous spike waveform, LFP, and
continuous raw data by checking associated boxes. Spike chain is checked by default.
Comments: You can add additional information to recording files before starting record.
Recording time: Use this box toset the duration (in seconds) of your recordings.
Recorded channel setting: Setup if the channel is recorded and select what type of continuous
data are selected.
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e Record Data Tab
Max Event num: Thisis the max number of events showed in Event Table. For example, if we setit
up to 50, the 51" eventwill be displayed on the firstline of Event Table.

Min Event Interval: This boxsets the minimum time expected foran event to take place. Default
this is set to 100mS. If more than one eventinputis to be recorded this needs to be set to 1.

Event Definition Table: Use this table to change the definition of the events recorded.

e System Gain Tab
System Gain: This displays the gain applied to the signal acquired by the DAQ. This cannotbe
changed.
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Start D ata Acquisition

After the configuration file has been loaded, you can tell the program tostartacquiring data by
clicking the Start DAQbutton. Starting the DAQ does NOT initiate a recording session.

Stop
J DAQ

!

NE“I’O@ware : r 0 Cuit Program

1™ Perurcirans W10 fongle v

Tasly  Help
k.
Ervim Livg Crpibvlanis
=— iop Mar Wimira LT ke EhL2-Chi [TV ST — [H—
o B oy
=X . Spitg Toom  THI1 le¥ s Display
= I
Hmw.\vara £} quisrrogram 108
10
Mahti-Chanmsl Tattings |  Racondad Chassels Rectuid Clata L
Sopsliew Dveplay Semieg Fimpry Eptaipnia [%:]
L4
]
Audin Butput Thrmwold Lavels
chw | TH3 o] T | = ol
o I B 3 .
L 1 Foom &l -
1 3 0 i o
Graph Satiings  Awio Trigger Seitings = N | - -
1 |« o =
20
Mooy = 'l a T
Spdle Witith Trigass | @ 7|4 = gl Fr]
5 ™ & b
T L L %
Pre Spke ' < "RhE | & L'
B Fy s 7 ewt a0
Spmpiry THE - = Wisdom
0 1 * AM = -
af 45 He
il dj — - — — . e = -
—_ _.T."_'."'“Id_m"ﬂ_ 4 | Chart zoam Centes gnsl  Diake Seledt Dy Ml Windew Width (=a)  Temaizama (1]
e mmni - 18 =] fpike Waebnom  |=| foopeChat (=] 400 161
T o a |l
1 7] T LELED
1 _|a |70 1 1azoe
|2 ) -
Appy Cuirert Thegybald T i #
= A0 Chanssh TRET o 1050
v ! o el ]

The Timestamp counter will begin toincrease as soon as you start the DAQ.

Chartzoom wemierSignal  Data Select Dizplay Made Window Width (ms)
10 = Splke Waweform = Seope Chart - 400

01

0.
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The raw data acquired by the DAQ will then be processed by NeuroWa re%’s digital spike and
LFP filters (if theyare enabled under the Filters tab).

NeuroWare ®’s spike detection functions utilize the data generated by the designated spike
filter settings. Only one spike filtered channel can be displayed ata time within the Main
Window tab.

Refer to the settings provided under the Spike Display Settings tab to configure spike
thresholdingand trigger conditions for each channel as theyare displayed in the Main Window.
Use the Channel counter to the left of the Spike Display chart under the Main Window tab to
cycle through yoursystem’s available channels.

Navigate to the Spike Chl1-Ch16, Spike Ch17-Ch32, Spike Ch33-Ch48, and Spike Ch49-Ch64 tabs
to simultaneouslyview those channels’ Main Window data streams. This is a good way to
quickly determine which channels still require trigger/zoom/filter adjustments.

Clicking the Clear Window button will dear the Spike Displayand the corresponding Spike Ch

tab chart of all detected spike waveforms. This is for viewing purposes onlyand will not delete
any recorded data.

Notch Filter

Notch Filter can be applied to the raw data ofall channels from DAQ card. Itis recommended to
review the Notch Filter Settings under the Filters tab before setting up spike triggering
conditions and browsing spike and LFP waveform.

NeuroWare © defaults the notch filtere nabled(Yellow) as shown below. You can choose to
disableit by dicking the Enable button.

NeuroWare© defaults the filter settings to the ones shown below. You can adjust the high,low
cutoff frequendes and orderany time.
Note: You may adjust the cutoff frequency based on local power line frequency
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Multi-Channel Settings | Recorded Channels

| Record Data

Spike Display Settings |

Spike Filter Settings

Enable

0

Filter Type

!
!

Bandpass

High Cutoff Freq: fh

Filters

LFP Filter Settings

Enable

o

Filter Type
Lowpass

High Cutoff Freq: fh

| Reference

”
Notch Filter Settings

Enable

D

Filter Type
Bandstop -

High Cutoff Freq: fh

Low Cutoff Freq: fl Low Cutoff Freq: fl Low Cutoff Freq: fl
300.00 B 300.00 B 45.00 B
Window Window Order
|Hann|ng E" |Redang|e E| |2 E”
Taps Taps v
201 B 201 B
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Spike Detection and Display
e Spike Filter

Itis recommended to review the Spike Filter Settings under the Filters tab before setting up
spike triggering conditions.

NeuroWare® defaults the filter settings to the ones shown below. You canadjust the high and
low cutoff frequendies any time before orduring a recording.

Alow cutoff frequency of more than 100Hzis recommended to remove the low-frequency
componentsignal.

Taps detemine the order of the digital filter. Selecting an odd number larger than 101 is
recommended.

Multi-Channel Settings | Recorded Channels | Record Data
Spike Display Settings | Filters | Reference
4 ] ™y ) ) . .
Spike Filter Settings LFP Filter Settings Notch Filter Settings
Enable Enable Enable
Filter Type Filter Type Filter Type
Bandpass |Z| Bandstop -
High Cutoff Freq: fh High Cutoff Freg: fh High Cutoff Freq: fh
7000.00 B 1.00 55.00 B
Low Cutoff Freqg: fl Low Cutoff Freqg: fl Low Cutoff Freqg: fl
300.00 B 300.00 B 45.00 B
Window Window Order
|Hanning E| |Rectang|e E| |2 E”
Taps Taps
201 B 201 B
\. y,
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e Spike Triggering

Once you hawe finalized your Spike Filter Settings, you can begin setting up the spike trigger
conditions, found within the Spike Display Settings tab.

| Multi-Channel Settings I Recorded Channels Record Data
Spike Display Settings | Filters Reference
Audio Output Threshold Levels
Ch# | TH1 (uV) | TH2 (V)| «
@ — IRED 70 F
) i ) 2 |28 70
Graph Settings  Auto Trigger Settings 3 Ve =0
4 43 -70
Minimum Trigger | @) 5 |43 70
Spike Width ‘,"J 5 E) =0
2 ¢ Uik 7 [43 70
ol
Pre Spike 01 =1 *RMS 8 43 =70 =
Samples TH2 9 43 -70
- 10 43 -70
20 < 0.1 2|l
RIS 11 43 -70
12 43 -70
Threshold Settings 13 43 -70
Threshold Selection Bl s 70
15 43 -70
Threshold1 and Threshold2 [~ | % a3 0 L
Trigger Mode 7|43 -70
Th1 First 18 |43 70
e [=] 19|43 70
20 43 -70
Apply Current Threshold 21 43 -70
to All Channels 22 |43 70
23 43 -70 2
e Audio Output
Audio Qutput

Ifanyspikeis detected in the currentselected channel, you will hear “pu” if Audio outputis
enabled.

Use the oval button to enable/disable audio output. The audio corresponds to the channel
currently displayed in the Spike Display chart. Drag the sliderto adjust the volume output.
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e Graph Settings

Graph Settings DAQ Spike ‘ LFP | Notch Filter | Chart Display | Reference - Record Data | Event | System Gain |

Minimum Spike Window Display Threshold Level
Spike Width . . . . |
2p . Min Spike Width  Pre Spike Samples Channel Selection Ch# | TH1 (uV) THZ (uV) =

—= a2 20 R 1 |33 -70
Pre Spike - - 2 28 70
Samples indows Samples Spike Repeat(=200] 3 43 -70

- rl 75 -
20 = 750 7 100 4 43 70
3 43 =70

Note: Windows Samples and Spike Repeat(<200) are onlyaccessible in Configuration
Dialog and you can’t change them when DAQis going.

Minimum Spike Width: the minimum number of DAQ samples required to cross the
threshold(s) to allow that portion of data to be registered as a spike

Pre Spike Samples: the number of samples the spike chart displays to the left of the
triggered data

Windows Samples: the number of samples the Spike Display Window.

Spike Repeat(<200): the numberof detected spike waveform overapped in the Spike
Display Window

e Auto Trigger Settings
Trigger Settings are located in Spike Display Settings tab
Auto Trigger Settings
Trigger \.‘}
TH1

01 | *RMS

THZ
0.1 = *RMS

Auto triggering applies toall channels and will take a few seconds to complete asit processes
samples from the current channel’s data. icking the Auto trigger button will automaticallyset
up triggerthreshold(s) foreveryavailable channel, which can be useful for quicklyidentifying
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possible spikes onany given channel. This functionsets the spike threshold(s) by calculating
each channel’s root mean square (RMS) voltage and multiplyingitbya user-defined rational
number.

If you wish to use auto triggering with both available thresholds (TH1and TH2), you must
enable them byselecting Threshold1 and Threshold2 from the dropdown listin the Threshold
Selection of Threshold Settings section found in the same tab.

e Threshold Settings

Two threshold sliders (green and yellow) are available toset up the threshold lewels. Simply
drag the sliders up and down to control the thresholds.

» Threshold1 (green cursor) is used to detect positive spikes.

» Threshold2 (yellow cursor) is used to detect negative spikes.

Threshold Selection
Threshold1: Only Threshold1is enabled.
Threshold2: Only Threshold2 is enabled.
Threshold1 and Threshold2: Both Threshold1 and Threshold2 are enabled.
Spike crossing Thresholdland Threshold2 will be detected.
Threshold1 or Threshold2: Both Threshold1and Threshold2 are enabled.
Spike crossing either Threshold1 or Threshold2 will be detected.

Trigger Mode: (onlyavailable when Thresholdl and Threshold2 is selected in Threshold
Selection)

Th1 First: Spike crossing Threshold1 firstand, then, Threshold2 is detected and

displayed.
Th2 First: Spike crossing Threshold2 firstand, then, Threshold1is detectedand
displayed.
Both Thl and Th2: Anyspike crossing both Threshold1 and Threshold2 is detected and
displayed.
Threshold Settings Threshold Settings Threshold Settings
Threshold Selection Threshold Selection Threshold Selection
Threshold1 and Threshold2 E Threshold1 and Threshold2 |T| Threshold1 and Threshold2 |E|
Trigger Mode Threshold1 Trigger Mode
- Threshold2 .
Thi First [=] « Threshold1 and Threshold2 Thi First [=]
~|  Threshald1 or Threshold2 |+ Thi First
Apply Current Threshold Apply Current Threshold Th2 First
to All Channels to All Channels Both Th1 and Th2
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The manually adjustable spike trigger thresholds apply only to the channel currently displayed
in the Spike Displaychart. These two threshold sliders (green and yellow), found on eitherside
of the chart, update the current channel’s trigger settings in real time. Simply drag the sliders
upand down orentera new value into the Threshold Levels table (found in the Spike Display
Settings tab) to control the individual positions of the thresholds.
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Spike Zoom slider will increase or decrease the vertical zoom within the Spike Display window.
If Zoom All Channels is checked, Spike Zoom will be applied to all Spike windows.

Clicking the Clear Window button will dear the Spike Displayand the Spike Ch1-64 windows of
all detected spike waveforms. This will not delete any recorded data.

Channel will select which channel is shown Spike Display and Strip Chart.

Spike Channels Tabs

Each of the Spike ChX-ChX panels containup to 16 individual spike channel windows.
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Error Log Optillap
Ma n Window Spike Ch1-Ch13 Spike Ch17-Chaz Wuli-Channel Viewer Events

p

Clear All Channel Windows

%

Charnel 1 Channzl 2 Charnel 3 Channzl 4

Channzl &

Zhennel 10 Channel 11

Zhennel 14 Channel 15

-106=

The same spikes detected by the thresholds from the Main Window are shown in these small
charts. dicking the Clear All Channel Windows button will dear the Spike Display and the Spike
Ch1-64 tabs of all detected spike waveforms. This is for viewing purposes onlyand will not
delete any recorded data.

Strip Chart
The Strip Chart is located at the bottom of the Main Window tab and displays the real-time

waveform of the channel selected for display within the Spike Display window.
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Chart Zoom ©—enter Signal Data Select Display Mode Window Width (ms)  Timestamp (s)
10 ( @_} Spike Waveform E Scope Chart E| 400 = 17
100.00-
T 50004
0.00-
0.1
-50.00-
0.01 -100.00-
Center Signal

Click the oval Center Signal button to automatically center the incoming signal to OV.
Data Select

Raw Data:displays theincoming raw data (unfiltered)
Spike Waveform: displays the selected channel with spike filter settings applied
LFP Waveform: displays the selected channel with LFP filtersettings applied

Display Mode

Strip Chart: displays the selected channel’s data as a constantly scrolling stream
Scope Chart: refreshes entire window with new data after chartis filled

Sweep Chart: same as scope chart, but continues to display previous data until itis
overwritten bynewerdata

Window Width (ms): adjusts the maximum amount of x-data displayed ata time

Chart zoom: increases or decreases the zoom of the Y-axis.

LFP Waveform

LFP waveform can be viewed by Strip Chart or Multi-Channels Viewer when selecting the right
data type.Itis recommended to review the Filter tab before viewing LFP. NeuroWare defaults
the filter settings to the ones shown as follows.
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Multi-Channel Settings | Recorded Channels

| Record Data

Spike Display Settings |

Spike Filter Settings

Enable

D

Filter Type
Bandpass El

High Cutoff Freq: fh
7000.00 =

Low Cutoff Freq: fi

Filters

| Reference

Enable

D

Filter Type

Lowpass El

High Cutoff Freq: fh

1.00

Low Cutoff Freq: fi

r . . ‘I . .
LFP Filter Settings otch Filter Settings

Enable

D

Filter Type
Bandstop -

High Cutoff Freq: fh
55.00 =

Low Cutoff Freq: fl

200,00 = 300.00 = 4500 s
Window Window Order
Hanning E Rectangle E 2 =
Taps Taps
201 = 201 :

e >

The high cutoff frequency will be ignored, but you can change the low cutoff frequencyatany
time, even during an experiment.

LFPsignals are of a much lower frequency than spikes, so three lower sampling rates (2K/s,
1K/s,and 7.5K/s) are available. But, the sample rate for LFP can only be accessiblein

Configuration Dialog and you can’t change them when DAQis going.
oA | Spke | LR | Mowh Fiher | Chan Gisplay | Reforence | Record Die | Evert |

LI® pample rase

2000 &

LFP Filer
fher type
! [P—n cligk To

[Emabde FIR

hirwr it freg:
o 200,00
g window
201 o ecrsngle

Multi-Channel Viewer

Every channel’s real-time waveform can be viewed within the Multi-Channel Viewer page.
Channels maybe added or removed from the Charted Chart in the Multi-Channel Settings tab.
A channel legend can be found to the left of the M-C chart.
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Charted Channels: Selectthe channels thatare displayed in Multi-Channel by Add or Remove
buttons

Center Signal
Click the oval Center Signal button to automatically center the incoming signal to OV.
Continuous Data Type
Raw Data: displays theincoming raw data (unfiltered)
Spike Waveform: displays the selected channel with spike filter settings applied
LFP Waveform: displays the selected channel with LFP filtersettings applied
Window Width (ms): adjusts the maximum amount of x-data displayed ata time

Zoom: increases or decreases the zoom of the Y-axis.

Interval: adjust the interval among the channels of Y-axis.
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Channel Reference

Under the Reference tab, dick the oval Enable Referencing button to enable channel
referencing. These settings may be adjusted during a recording if necessary, and any changes
will be reflected in real time.

When channel referendng is enabled, the selected Reference Channel (within the Reference
Settings box) will be applied to the channel currently being viewed in the Spike Display chart.

Click the Apply Current Reference to All Channels button to change every channel’s reference
channel ormanuallyenterany channel numberinto the Channel Reference Chart to change
reference channel forindividual channel. So, you are able to select different channel as
reference channel.

Note: If Referenceis enabled, both Spike and LFP filter will function based on referenced data.

Multi-Channel Settings Recorded Channels | Record Data |
Spike Display Settings Filters | Reference |

Channel Reference Chart
Reference Ch# &

Reference Settings

o]
=5
B3

Enable Reference
Referencing Channel

Apply Current Reference
to All Channels
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Record Data

e File Types
IT IS IMPORTANT THAT CUSTOMERS RECORDING MULTIPLE SIMULTANIOUS, CONTINUOUS
DATA TYPES CHANGE THE RECORD FILE LOCATION TO A D DRIVE. RECOMMENDED
HARDWARE IS A SATA 3 (6GB/S) SAMSUNG EVO SSD 500GB OR LARGER.

Nex File: a type of binary file with predefined file headerand data body.

Spike Display Settings Filters | Reference | Spike Display Settings Filters | Reference
Multi-Channel Settings Recorded Channels | Record Data ‘ Multi-Channel Settings Recorded Channels | Record Data
File Type Recording Data Selection File Type Recording Data Selection
Nex File -] TxtFile [*]
File Save Path Spike Train File Save Path Spike Train
CATBSlrecording file  ~ CATBSIrecording file  ~
Spike Waveform Spike Waveform
A [¥| Continuous Data = Continuo
Record Duration (s) i Record Duration (s) ntinuous Data
5 = Continuous Data Type 5 = Continuous Data Type
Comment Raw Data |Z| Comment Raw Data -
- -
[¥] Analog Input Channel [¥] Analog Input Channel
Start time Start time
Stan‘J'Stpp | | Start/Stop | |
Recording Endtime Recording Endiime
Elapsed Time(s) | | Elapsed Time(s) | |

° I | ° I |

If Nex Fileis selected, Seven types of data maybe generated by NeuroWare aftera recordingis
complete upon the selected options in Recording Data Selection.

Event.nex: Digital eventlog (ex.leverpressoraudio tone).

SE-CSC-LFP-Ch#.nex: Continuous LFP filteredand referenced neural signal from channel #.
SE-CSC-RAW-Ch#.nex: Continuous neural signal referenced from AGND channel #.
SE-CSC-SPIKE-Ch#.nex: Continuous SPIKE filtered and referenced neural signal from channel #.
SE-Spike-Ch#.nex: — spike waveform detected by NeuroWare threshold on channel #.
SE-Spike-TS-Ch#.nex: Timestamp train of detected spikes on channel #.

Analog Input Ch#.nex: Analog signal from BNC connector.
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NeuroWare defaults the file path for recorded file to C:\TBSI\recording file. Change the file path

before start recording if needed.

e Recording Data Selection
If Nex File is selected, Spike Train is selected by default. Spike Waveform, Continuous Dataand
Analog Input Channel are ready for being selected.

If Continuous Datais checked, you geta chance to select whatkind of datais recorded.

Raw Data: the incoming raw data (unfiltered)
Spike Waveform: data with spike filter settings applied
LFP Waveform: data with LFPfilter settings applied

Analog Input Channel is particulady for BNCanalog input.

e Comments

Anyinformation less than 256 char typed in Comment will be notonlysaved in Nex file, but
alsoin “Note.txt” file which isin the same folderas Nexor Txt file.

e Recorded Channel

All channels will be recorded by default. You canadd or remowe the channel by dicking
Remove or Add button in Recorded Channels tab.

Version 1.2

-28-

1/2014



NeuroWare® User’s Manual

Spike Display Settings | Filters | Reference
Multi-Channel Setings |  Recorded Channels | Record Data
Available Channels Recorded Channels

Ch# Description - Ch# Description -
I 1

13 2

19 3

20 4

1 5

22 - B

23 B Add | (7

24 2

r

ﬁ: @ Remove 30

27 11

28 12

29 13

20 14

T 15

|

e Recorded File Name
By default, the Nexfiles are named as SE-CSC-Ch#_.nex/ SE-Spike-Ch#_.nex/SE-Spike-TS-
Ch#_.If you want to change them, you can go to Configuration Dialog to add suffix to each
channel. Forexample, if you type in Neuronlin Chland Neuron2in Ch2, the recorded file
name will be SE-CSC-Ch1_Neuronl.nex.
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e Start/Stop Recording
Itis recommended to review the Charted Channel, File type, Recording Data Selection and
Record Duration before recording. Record Duration is required to be a number with the unit
Second, which means you have to convert the recording time to time with the unitsecond.

Click Start/Stop recording button tostart recording. The recording process can be monitored
either by Elapsed Time or by progress bar.

Whenever you want to stop recording before Record Duration run out, you can dick Start/Stop
recording.

e How to Load Nex File
The .nex files generated by NeuroWare can be loaded directlyinto NeuroExplorer for analysis.
These binary files canalso be loaded into Matlab —please refer to the Appendixfordetails.

e How to Load Text Data
The .txtfile generated by NeuroWare is an ASCII file which can be loaded directlyinto MS Excel.
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Events

NeuroWare can detect the status change of up to 24 digital lines within the ADC DAQboard.
Digital level changes (such as 0>1or 1-0) are thoughtof asan eventand can be displayed and
recorded in NeuroWare.

*The ADC cannot support simultaneous changes on different channels. For this reason
TBSI does not support the use of more than one Digital Data input at a time.

e Digital Lines Connection
All 24 digital lines are accessible with a 68-pin SCSI connector. A couple of digital lines are also
accessible with BNC connector.

Connect the digital signals of interest to yoursystem via pins A0-A7,B0-B7,C0-C7 (shown
below).

e Digital Events
Digital level changes of 24 digital lines are defined as different Event ID within NeuroWare (see
table and image below).

Any changes to the eventvariables AO>A7,B0—->B7, CO->C7, will be shown in the Event Table.
Forexample, if the digital level of the AQline changes, you will see aneventin the Event Table
as shown below.
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Event Definition Table Event table

11 AD_high - Timestamp | Port_status Event_ID | Event_String ﬂ
= ] 13.8030 00000000000000000000] 10 AD_low

10 Al_low | 12.8030 10000000000000000000] 11 AD_high

21 A1_high r 11.8030 00000000000000000000] 10 AD_low
= 10,8020 10000000000000000000] 11 AD_high

20 Al_low 10,3020 00000000000000000000] 10 AD_low

ey A2 high 8.9020 10000000000000000000] 11 AD_high

30 A2_low

41 &3 high

40 A3 low

51 Ad_high

50 Ad low

i1 A5_high

60 A5 low i i

The Event String can be changed to better describe the details of the event. You can define your
own Event Definition Table by the page of Event of Configuration Dialog as shown below.

Event Definition Table: the defaultstringis named as PortNum_High / PortNum_Low

Max Event Num: the maxnumberof events that’s displayedin EventTable. It’s for

display purpose only.

Max Event Interval (ms): the min width of pulse that can be detected as digital event
is decided by this number. You are able to change it down to 1ms while
the defaultis 100ms, but the measurement difference of tens of ms
may still be seen depending on your computer performance.

Note: Event Definition Table can’t be edited in NeuroWare.
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(P9 canfiguration Dialag 1.8, |
DA | Spike | LFP | Motch Fiker | Chart Display | Reference | Record Data | Event IS,mmﬁc.‘n|
@h_ Event Defnition Table
1 11 A0_high =
; WHI'E Max Evert rum | =
b
Min Event Interval (ms)
Load New Canfig J.’?
Save
Save As
Feturn to
MNeuroWare

e Event File
Digital eventinformation stored within the event.nexfile (shown below) can be loaded into
NeuroExplorer.

5/3/2012 12:29 PM MEX File 2,032 KB
| SE- -Chl.nex 5/3/2012 12:29 PM MEX File 864 KB
|| SE-CSC-Ch2.nex 5/3/2012 12:29 PM MEX File 864 KB
] SE-CSC-Ch3.nex 5/3/2012 12:29 PM MEX File 864 KB
|| SE-CSC-Chd.nex 5/3/2012 12:29 PM MEX File 864 KB
[ | SE-CSC-ChS.nex 5/3/2012 12:29 PM MEX File 864 KB
|| SE-CSC-Chb.nex 5/3/2012 12:29 PM MEX File 864 KB
] SE-CSC-Ch.nex 5/3/2012 12:29 PM MEX File &64 KB
|| SE-CSC-Ch8.nex 5/3/2012 12:29 PM MEX File 864 KB
| SFr e h ne G/273017 1770 DA MEY Eil= fRA KR
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M Eventnex L]
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File Commenik:
Dur e 5 ErH File SupeiE]: 2.081
FrequencylHal: X000 Meurons: o
Evenis: ] Pop, Veciors: -]
Markesi: o e -]
Tt ] Cont. Vane.: -]
Mew Vorabie... e Inberwaki... v Yockm... Prosibarm.
Warkable T-stamps | Count Hean Freqg
Fibar = =
1 Gl tSiop 2.000
2 AlFie ixd 500
E

Lal*\Yariables £ Tincetampz J, Intervals f, Wavefcraz J, Pep. 9] ¢ L

Analog Input Channel

An analog input channel separated from the otherneural channelsis provided for custom

purmpose. The TTL waveform up to +/- 5V can be acquired by DAQdirectlyat up to 30kS/s. Also,
no filter will be applied to this channel.

Analoqg Input (V)

Al}‘_c_ou_fjle Window Width (ms)
Y-Zoom (.--,__@.} 10 -
10 5=
U_
| A
B | | ERERERE RN
0.01 -5-
Version 1.2 -34 -

1/2014



NeuroWare® User’s Manual )

Error Log Window

The Error Log window helps trace problems that have occurred within NeuroWare. Please
consult this page if you experience problems during re cording.

Allerrors are loggedinto a .txt file located in the directory specified within the Error Log File
Path field.

J Main Wandow | Spike Chi-LCR1G | Speie ChA7LREZ | Mul-LChannal Viewer | Events
Errar Log OptiMap

ErrorLeg

Quit NeuroWare

To quit the program, dick the Quit Program button which is located beneath the Start DAQ
button or close panel directly. It's recommended to check if you like to save the current setting
to the current config file orsave as a new config file by Configuration Dialog
(Tools/Configuration)

start | Stop
& Lzlss
. \

Neuro@Ware“ [0 Quit pmgrm]
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Click OK in the next dialog box to confirm that you want to quit.
7 s

Are you sure you want to quit?

E Ok [ Cancel ]

Reading files

e Load Data into NeuroExplorer
Load the NeuroExplorer program, navigate to File—>Open and open SE-CSC-Ch#.nex (where #is
the channel of your choice).

& Mourekaplarer - [SE-CSC-Ch e Data]
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e Load Data into MatLAB

Visit the NeuroExplorer website at http://www.ne uroexplorer.com/code.html to download the
.nex file reader/writer function for MatLAB, titled: HowToReadAndWriteNexFilesinMatlab.zip.

Copy the readNexFile functionin the archive to the folder containing your recorded data. In the
MatLAB command window, execute:

readNexFile SE-CSC-Ch# .nex
(where #is the channel of your choice)
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In the MatLAB workspace,double-dick the variable labeled ans. The Variable Editor window will
appear.
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In the Variable Editor, double-dick contvars.
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Double-dick the <1x1 struct> cell to extract the data content.

8% Variable Editor - ans.contvars

File Edt %iew Graphics Debug Deskiop ‘Window Help ‘lll x
R R ] -~ P —— - BOES0O
[£3} ans.conkvars <7l el

1 2 3 4
1 [E11 struct>

Ll iif >
©oans x| ans.conbvars  x
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& Variable Editor - ans.contvars{1,1}

File Edit Wiew Graphics Debug Desktop ‘Wwindow Help L'l | A X

% | # E=) . | gé | ‘ - | E |Stack: Base |@No valid ploks for: ans.contva.., « HOH® ||:||
ans.conkvars{l,1} <1x1 struck>
Figld - Yalue Telin Max
name “Con Chi O
wariersion 101 101 101
HH antary 1 1 1
EM\!’OFFFSBI: 5,0135e-154 6.013... 6.013.
EE ADFrequency 30000 30000 30000
EE timestamps 3.2653e+03 3265, 3,285,

100001 double=

Goans % | ans.contvars x|| ans.contvars{1,1} ><|

Technical Support

All technical support and application questions should be directed to John Mcdntyre at Triangle
BioSystems.

Contact Information
Phone: (919) 361-2663
Fax: (919) 544-3061
http://trianglebiosystems.com/contact-us.html

Version history for this manual
1.0 Initial release with Specifications 11/2013
1.1 Removed functionality table, added 1/0 1/2014
1.2 Added info for config dialog box 1/2014
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